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Metodicky list Programovani v Pythonu 3. lekce

Cile lekce
« Naucit se pouzivat piikaz print, ktery je ureny na vypis textii a ¢iselnych hodnot
« Pochopit, co je to program, jak se zapisuje a vykonava
«  Pochopit, Ze texty jsou jiné nez ¢isla

« Seznamit se s riznymi chybovymi situacemi v programech

Dovednosti
« Vytvofeni a uloZeni programu
« Vicendsobné spousténi programu

« Prepindni se mezi oknem editoru a interaktivnim oknem (konzoli)

Osvojena syntakticka pravidla
« Zapis pitikazu print a jeho parametra

«  Zapis texth pomoci apostrofit nebo uvozovek

Pribéh vyuky

Prvni dloha slouZi k zopakovéani poznatkli z minulé lekce.

1. Do proménné suma pfifad’ pocet korun, které budeS ménit na eura. Do proménné kurz
piifad’ kurz eura (napiiklad 1 euro za 25.23 korun). Do proménné dostanes pfifad’
hodnotu vyrazu, kterym se vypocitd, kolik eur dostanes za ménénou sumu. Zacni takto:

>>> suma = 100
>>> kurz

Ocekavané feseni:

>>> suma = 100
>>> kurz = 25.230
>>> dostanes = suma / kurz

>>> dostanes
3.963535473642489

Doposud se zadavaly piikazy samostatné¢ do piikazového taddku v interaktivnim reZimu. To
bylo vyhodné, pokud Zzici Python pouZzivali jako inteligentni kalkulacku, piipadné se
seznamovali s konceptem proménné a dé€lali drobné experimenty. V této lekci chceme naucit
7zéky sestavovat programy. Aby program dokdzal zobrazovat vysledky, je potieba Ziky
sezndmit s pfikazem print.Zafindme jednoduchymi vypisy, stile v interaktivnim reZimu.
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2. Vyzkousej novy piikaz. Co vykona?

>>> print ('Ahoj, Jj& Jsem pocitac')

\ /

toto jsou apostrofy — najdi je na kldvesnici

Piikaz print slouZi na vypisovani textl. Text, ktery se md vypsat, napiSe§ mezi
apostrofy.

V téchto materidlech budeme texty uvadét v apostrofech, ackoliv stejné tak bychom mohli
pouzivat uvozovky — tj. print ("Ahoj, Jj& Jjsem poc&itac"). Nechceme Zziky
zatézovat obéma variantami. Rozhodli jsme se pouZivat apostrofy, protoze ty se v jazyce
Python pouzivaji obvykle. U Zaki nemusime trvat na pouZzivani apostrofi, pokud by chtéli
pouzivat uvozovky. Pfi psani téchto pfikazli mohou mit Zaci zpocatku problémy s pouZitim
spravnych symbolii, nebot’ na ¢eské klavesnici existuji rtizné typy znaka, které vypadaji jako
apostrofy. Zaci nemusi vypisovat texty s diakritikou — budeme spokojeni napiiklad i s vypisem
print ('Ahoj, Jja jsem pocitac').

Se zaky muzeme diskutovat, co znamend anglické slovo print, i o tom, Ze v jazyce Python
ma tento piikaz vyznam vypsdni do interaktivniho okna.

Nésleduje tloha na trénovani:

3. PouZij print a vypi§ pomoci né¢ho jména dvou svych kamaradu, napiiklad:

Moji kamaraddi jsou VasSek a Jana.

Resent:
>>> print ('Moji kamaradi jsou Vasek a Jana.')
Moji kamarddi jsou Vasek a Jana.

Cilem nasledujicich experimentt je, aby se Zaci 1épe seznamili s piikazem print:

4. Zjisti, co Python vypiSe v pfipad¢ nasledujicich piikazh:
>>> print (1 + 2 * 3)
>>> print ('l + 2 * 3")
>>> print ()

Vidi§, Ze print vypiSe i hodnotu vyrazu, kterd neni mezi apostrofy.
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Zéci by méli piijit na nasledujici poznatky:
* Obycejné vyrazy v piikazu print se vyhodnoti a zobrazi se jejich hodnota:

>>> print (1 + 2 * 3)
7

* To, co je v apostrofech, pocita¢ nevyhodnocuje, i kdyby to byl standardni vyraz:
>>> print ('l + 2 * 3'")
1 +2 * 3

e V piikazu print nemusime uvést, co chceme vypsat — pak se zobrazi prazdny
radek:

>>> print ()

Upozornéni pro ucitele: slovo print lze napsatibez zdvorek, jen jako slovo:

>>> print
<built-in function print>

Potom Python zobrazi informaci, Ze print je standardni piikaz (funkce) jazyka Python.

Cilem nésledujicich uloh je, aby Zaci zjistili, Ze v pfikazu print mohou uvést vice textl
a hodnot, které se postupné za sebou vypisi (pfitom plati, Ze jeden pitikaz print se rovna
jednomu tadku vypisu). Tento zplsob vypisu chceme pouZit proto, aby s ndmi Python

srozumitelné komunikoval:

5. Pfikaz print umi vypsat vic véci — vyzkouSej nésledujici piikazy. Co zpusobi ¢arka
v jednotlivych ptikazech?
>>> print ('Mam rad', 'kapustu')
>>> print ('Moje oblibené cislo je', 42)
>>> print ('Do Skoly jsem Sel', 2 * 10, 'minut')

Z4ci by si m¢li v§imnout, Ze:
* Vysledny text bude na jednom fadku, mezi vypisované texty se vloZi mezera:
>>> print ('Mam rad', 'kapustu')
Mam rad kapustu
* MiZeme kombinovat texty i hodnoty (a mezi vypisované Casti se téZ vlozi mezera):

>>> print ('Moje oblibené c&¢islo je', 42)
Moje oblibené ¢islo je 42

* KdyzZ uvedeme vyraz, ten se vyhodnoti a na obrazovku se vypiSe vysledek:

>>> print ('Do Skoly Jjsem Sel', 2 * 10, 'minut')
Do Skoly jsem Sel 20 minut

Upozornéni pro ucitele: je potfeba davat pozor na ¢arky — pokud chybi, zobrazi se chybové
hlaSent:

>>> print ("Moje oblibené cislo je' 42)
SyntaxError: invalid syntax
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Nasleduje uloha na trénovéni:

6. Vypis pomoci piikazu print svoji vysku ve tvaru:
Mérim 180 cm

V piikazu print neddvej svoji vySku mezi apostrofy.

Resent:
>>> print (Mér¥im, 180, 'cm')
Mérim 180 cm

Dalsi dlohy jsou zaméfené na chybové zpravy, aby se Zaci postupné naucili, co znamenaji
a kdy se mohou vyskytnout:

7. Prozkoumej, co se stane, kdyZ zapomeneS napsat v piikazu:

>>> print ('Ahoj) ... apostrof?

>>> print (Aho3j) ... oba apostrofy?
>>> print 'Ahoj' ... zadvorky?

>>> print ('Ahoj' 10) ... Carku?

Zéci by méli vidét nasledujici chybov4 hl4sen:
*  Chybéjici apostrof — neukonceny text:

>>> print ('Aho7j)
SyntaxError: EOL while scanning string literal

e Chybéjici oba apostrofy — Ahoj je chdpano jako proménnd, do které jsme ale
nepfifadili hodnotu:
>>> print (Ahoj)
Traceback (most recent call last):
File "<pyshell#20>", line 1, in <module>
print (Ahoj)
NameError: name 'Ahoj' is not defined

e Chybgjici zavorky:

>>> print 'Ahoj'

SyntaxError: Missing parentheses in call to 'print'
*  Chyb¢gjici ¢arka:

>>> print ('Ahoj' 10)

SyntaxError: invalid syntax

Se zaky miizeme o chybdch a jejich vyznamu diskutovat (vyznam v cestin€). Ze znalosti
chybovych zprav vSak zdky nezkouSime.

2N s

Nyni se Zaci sezndmi s postupem, jak se vytvaii novy program. V budoucnu budou tento
postup Casto opakovat.
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8. Zatim jsi s Pythonem pracoval v interaktivnim rezimu. Za symboly >>> jsi zapisoval
jednotlivé ptikazy, které se ihned vykonaly. Déle budes vytvafet programy — nejdiive
napisesS vSechny ptikazy, az potom tento program spustis.

A. Z hlavni nabidky zvol File » New File:

Edit  Shell Deb\fg_ Options Window  Help

I . 6. £ :d48eceb, Dec 19 2017, 06:04:45) [MSC v.1900 *
Open.. Ctrl+0 on win3Z?

Open Medule..  Alt-M : . ’ .
R::enmles , "credits" or "license ()" for more information.

Module Browser Alt=C
Path Browser

Save Ctrl+S
Save As... Ctrl+Shift+5
Save Copy As.,  Alt+Shift=S

Print Window Ctrl+P

Close Alt-F4
Exit Ctrl+Q

4 it Format Run Options Window Help
|l crint ("Ahoj"')
Mporint ('Pozdravuje té& Pythcn')|

Ln:2 Col: 29 |
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3. lekce

_M[[Eie) £dit Format Run Options Window Help

D. Uloz program do souboru volbou z nabidky File » Save:

New File Ctrl+ I
Open. Ctrl+0
Open Module..  Alt-M
Recent Files
Module Browser Alt-C
Path Browser

t& Python')

Cirl+§
Save As. Ctrl+Shift+5
Save Copy As..  Alt+Shift+S

Print Window Ctrl+P

Cloze Alt+F4
Exit Ctrl+Q

Save:

<« Programs » Bython » Python36-32 »

Uspofadat + Nové slozka

¢ Oblibené polozky |i‘ Nézev.palathy
% Neposledy navitivel=| 1L DLLs
& OneDrive M e
I Plochs |/ include
1§ Stazené soubory Il Lib
) libs
B Plocha | Scripts
4 Knihovny | tel
|| Dokumenty | Tools
o Hudea
=] Obrazky

11.2201811:43

il Subversion =

Nazev souboru: | prvni|

Ulodit joko typ: [Python files

| = skt stoziy

F. Nyni program spust’ volbou Run » Run

Format - Options  Window Help

print ("2 Python Shell
print (' Pq_ CheckModule Atk

Run Module 5

ython')

E. Najdi sloZku, do které chces soubor uloZit. Potom do policka File name napiS$
nazev souboru, napiiklad prvni.py (pfiponu psiat nemusiS), a klikni na tlacitko
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G. V interaktivnim okn¢ uvidis vysledek:

| preni.py - C/python/armipy (36.4) ==
(3 2yhon 36 el )
File Edit Shell Debug Options Window Help
Pyth@n'3.6.4'(V3.6.4:d48eceb, Dec 19 2017, 06:04:45) [MSC v.1900 =
32 bit (Intel)] on win32
Type "copyright", "credits" or "license ()" for more information.
>>>

RESTART: C:/python/prvni.py ===========

Ahoj
Pozdravuje t
]

(%

Python

ol ]

Ln:7 Col: 4 [ff

Je potieba si uvédomit, zZe Zaci mohou mit nasledujici problémy:

Od kroku B uvidi Zaci vice oken. Problém miiZe byt v orientaci, ve kterém okné se
praveé nachdzi, ve které hlavni nabidce maji hledat potfebné polozky (napft. kde spustit
program).

Najit misto, kam soubor uloZi (to zdleZi na nastavenich v pocitacové ucebn¢).

Do kterého okna se od této chvile piSe program a do kterého se zobrazuji vypisy
pomoci piikazu print.

Kam a jak se budou zobrazovat chyby v programu.

Zamysleni:

Zéaci budou radi, kdyZ se sezndmi s kldvesovymi zkratkami F5 pro spusténi
programu, Ctrl+N pro novy program, Ctrl+S pro uloZeni souboru. Z naSeho
pohledu jsou toto pro nckteré Zaky uZzitecné pomucky, ale urCité zaky ze znalosti
klavesovych zkratek nezkouSime.

KdyZ zménime program a neuloZime jej (Ctr1+S), Python se pfed spusténim dotdze
na ulozeni souboru. Toto mliZe byt Casem obtézujici. Pokud uznéte za vhodné, nastavte
prostiedi Python v pocitacové ucebné tak, aby byl program pied spusténim
automaticky uloZen do souboru:

© v hlavni nabidce zvolte Options » Configure IDLE

o v dialogovém okné, které se zobrazi, zvolte zdlozku General

© v casti Autosave Preferences zvolte volbu s nizvem No Prompt



Metodicky list Programovani v Pythonu 3. lekce

Cilem nésledujici dlohy je, aby si Zaci natrénovali postup pfi editovani a spousténi programu.

9. Piepni se zpét do svého programu a piidej dalsi piikaz print, kterym vypiSe$ text
~Dnes je stfeda™ (misto stfedy doplil aktudlni den v tydnu). Program uloZ a spust’
jej-

Resent:
print ('Ahoj")
print ('Pozdravuje té Python')
print ('Dnes je stfeda')

Zaroven zaci sbiraji zkuSenosti, jak se vykondva program, ktery obsahuje vice piikazi za
sebou. Zjisti, Ze pocitac ptikazy vykona postupné tak, jako kdyZ my Cteme text.

Cilem ndsledujicich tdloh je trénink vytvéafeni novych programii, pouzivani piikazu print
a spousténi, ptipadné opravovani programt.

10. Vytvor program basnicka.py, ktery vypiSe tryvek tvé oblibené bdsnicky nebo
pisnicky. Jestli t€ Zddna nenapadd, mizes vypsat tuto basnicku:

Na topole nad Jjezerem
sedél vodnik podvecerem:
Svit, mésicku, svit,

at mi Sije nit.

Reseni:
print ('Na topole nad Jjezerem')
print ('sedél vodnik podvecerem: ')
print ('Svit, mésicku, svit,')
print ('at mi $ije nit.'")

11. Pomoci piikazu print se daji vypisovat veselé véci. Vytvof novy program
vizitka.py, ktery pomoci piikazu print vypiSe tvoji vizitku, napiiklad takovouto:

Petr / o o
RUMCAJS \ ~

~

IT loupezZnik
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MozZné teSeni:

( \

( \}

(" Petr / o o\
print (' RUMCAJS \ ~ /

( \ mman

( \}

( \

IT loupezZnik

V této dloze:

* Predpokldaddme, Ze si Zaci vytvori svilj obrazek

e Zaci musi vytvofit novy program, vhodné jej nazvat a uloZit,

3. lekce

* KdyZ Zaci pouziji ve své vizitce néjaké specidlni znaky, ty mohou délat problémy,

napftiklad:

© Pokud by ve vypisu chtéli pouzit apostrof (nebo v piikazu print pouZivaji na
oznaceni textu uvozovky a 1 ve vypisovaném textu by chtéli pouZzit uvozovky),
o Zpétné lomitko \ se v textu pouZzivd na zaddvani specidlnich symbold — pokud je

za znakem mezera, tehdy je to v potadku,

print ('\x0e') vypiSe J.

ale napiiklad kombinace

#H#EE # # #EHESE # # #HE # #
# *o# # # # *o# *o## #

12. Vytvor program python.py, ktery ze znaki # (kiizek) vypise zvétSeny text PYTHON:

##44 ##4 # ##H4#4 # ¥ # # #
# # # # #  ##HE # #
# # # # ¥  ##4 4 #
Resent:
print ('#### # # #HEHH# # #  ##4E #
print ('# # # # # # # # # #
print ('#### ##4 # FH### # # #
print ('# # # # # # # #
print ('# # # # #  ##HE #

nebo prezdivku. Vyska pismen bude nejméné pét radka.

13* Vytvof program prezdivka.py, ktery ze znaki $, € nebo jinych vypiSe tvoje jméno

MozZné feSeni:

print ('€ € €€€ £ £ <€€€')
print ('€€ €€ € € € € ")
print ('€ € € € €€ € ")
print ('€ € € € € € ")
print ('€ € €€€ £ £ €€€')

Zatim jsme umyslné vypisovali jen texty a konstantni vyrazy. Vyraziim s proménnymi se

budeme vénovat v dalsi lekci.
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